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macOS Hidden Treasures: The Mac’s Hidden Markup Tools
by SHARON ZARDETTO

Have you ever had an image that just begged 
for a speech balloon with a snarky comment 
coming from your spouse (or baby), or needed a 
villainous Snidely Whiplash handlebar mustache 
added to your boss (or baby)? Ever wanted to 
highlight or magnify part of an image for special 
attention, or simply crop a screenshot or other 
image?

You don’t have to open the image in Preview to 
avail yourself of its special markup tools, and then 
copy or otherwise use the altered version. While 
Apple’s productivity apps (Pages, Numbers, and 
Keynote) have a plethora of native markup-like 
tools, the company’s other apps that can contain 
images—Photos, Mail, TextEdit, Stickies, Notes, and even (in macOS 10.14 Mojave only) Messages—
can now employ markup tools. As if that’s not enough, Mojave also incorporates these tools throughout 
the Finder and even within its new screenshot interface.

Enable the Mac’s Markup Tools
Extensions are little plug-in utilities that add functionality to programs. Back in 2014, Apple added the 

Markup extension in 10.10 Yosemite, along with the Extensions preference pane; neither got the 
attention it deserved.

Enable markup capability in System Preferences for three areas in Mojave:
1.   Go to System Preferences >  Extensions.
2.   Select Actions in the list, and check Markup in the panel.
3.   Select Photos Editing and check Markup.
4.   Select Finder and check 

Markup. (You should also 
check the other three items, 
but I’m not covering their 
usage in this article, except for 
one, in passing, in “Quick 
Tips.”)

In High Sierra’s Extensions 
preference pane, activate Markup 
for Actions and Photos—there’s 
no Finder option.

Access the Markup Tools
How you get to your markup 

tools depends on where you’re 
working:

• In Photos: In Photos, you can access the markup tools when an image is in Edit mode. (Zoom a 
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SIG NEWS

No Sig Meeting in December!

For more information about Special Interest 
Groups (SIGs), go to the SMMUG website.

Scan this QR code to be taken to our 
SMMUG web site

ADVERTISING
You can advertise your business or service 
through the Silicon Summit.
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Quarter page   $15 
Half page   $25 
Full page   $50 
Insert                  $15

A 10% discount is applied for ads that 
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Sponsor ing Membersh ips a re a l so 
available to merchants who want to see 
their business name and address listed on 
the front page. Sponsoring Memberships 
are $100 for one year.

MEETING DATES
 

Our regular monthly meetings are on the second 
Monday of every month. Upcoming meeting 
dates are as follows:

 
December 10, 2018
-----------------------
January 14, 2019
February 11, 2019
March 11, 2019

April 8, 2019
May 13, 2019
June 10, 2019
July 8, 2019

August 12, 2019
September 9, 2019
October 14, 2019

November 4, 2019*
December 9, 2019

* Meeting Date changes

                                                                              
MISSED AN ISSUE?

You can find the previous issues of the 
Silicon Summit posted in PDF format at 
the SMMUG website.

THIS MONTH AT SMMUG

December 10, 2018
6:00 Q&A Session
6:45 Networking Break
7:00 Annual election & 5-10 min member 

presentations 
8:00 Adjourn

Upcoming Meetings
January: HomeKit, Home Automation 

update, Smart Home apps
February: Panel: Screen capture programs
March: Free Office suite alternatives to iWork 

and MS Office

Silicon Summit is a monthly 
publication of the Silicon 
Mountain Macintosh User Group, 
Inc. 

Newsletter Editor
L. Davenport

Web Masters
Jeff Jensen, Ralph Woodard

Apple Ambassador
Mark Griffith

© All material in this newsletter is 
Copyright 2018 by the Silicon 
Mountain Macintosh User Group, 
Inc. (SMMUG, Inc.).

Silicon Summit is an independent 
publication and has not been 
a u t h o r i z e d , s p o n s o r e d o r 
otherwise approved by Apple Inc. 
The Mac and Mac OS logo are 
trademarks of Apple Inc., used 
under license. Views and opinions 
expressed in Silicon Summit are 
those of the authors and not of 
SMMUG.

OFFICERS
President

Jim Johnson
mahatma@freemasonic.org

Vice President
Mark Griffith

megriff@mac.com

Treasurer
Skip Mundy         
skip2@mac.com

Secretary
Ron Davenport                 

rdavenport@smmug.org

Directors at Large
Jeff Jensen

jeffj@smmug.org 

Mike Marus
jmarus@me.com

Sharon Romero
sromero@smmug.org

Pam Wilson
pwilson@smmug.org

Ralph Woodard
rwoodard@smmug.org

http://www.smmug.org/meeting-info
http://www.smmug.org/meeting-info
http://www.smmug.org/join-smmug
http://www.smmug.org/join-smmug
http://www.smmug.org/category/newsletters
http://www.smmug.org/category/newsletters


3

Announcements
Elections for 2019 SMMUG Officers and Board of Directors Members

We will be electing our new SMMUG Officers and Board of Directors for 2019 at our General Meeting on December 10, 2018. We have all 
benefited from the information given out at our club meetings. So it is time to think about giving something back. Can you spare an hour each 
month to help support your club by becoming a 
member of the Board? Not sure what being a Board 
member involves? Descriptions for each of these 
positions are available in our Bylaws available under the 
"Contact Us" tab at www.smmug.org.

If you are nominating someone other than yourself, 
please ensure the person is willing to accept the 
nomination. 

You must be a current paid member in good standing 
to vote. Each member in good standing can vote once 
either by e-mail or in person at the Annual Meeting. If 
you cannot make the December 10th Annual Meeting 
or if you would rather vote via e-mail, please title your 
e-mail “SMMUG Vote” and send in your vote to our 
Election Committee Chairperson, Rich Voelker at 
smmugvote@voelker.com.  Please title your e-mail, 
“SMMUG Nomination”. You may vote once for each 
position. All e-mailed nominations and votes must be in 
by 7:00 p.m. December 10, 2018.  

If you have questions, please e-mail the SMMUG 
Board at info@smmug.org or click on the “Contact 
Us” tab on our website, http://www.smmug.org. 

Special Offers
For a limited time, SMMUG members can 
purchase Video Duke for 50% off. The discount 
coupon code can be found in our Member’s only 
web page. BTW: We have 3 copies for our Door 
Prize drawing, so you might want to wait to see if 
you win one before purchasing.

Door Prizes For The December 
Meeting:
3 Video Duke software programs
32GB thumb drive
Grip Pad
iPhone stand 

Club News
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thumbnail with a double-click and then click Edit in the upper right, or just select a photo and press Return.) Click the More ••• button in the 
toolbar and choose Markup from its menu; the Adjust pane disappears from the right of the window, and your markup icons are displayed along 
the top of the image.
• In other Markup-savvy apps from Apple: In apps such as TextEdit, place an image in the document and then hover over its upper-right 
corner until you see a down-arrow button; click it, and choose Markup from its menu to open the markup window. 

• In the Finder: Mojave lets you use markup tools right in the Finder, where you can access them in many ways.
• Quick Look windows: Quick Look? It’s not Apple’s fault if you’ve ignored this handy Finder feature that 10.8 Mountain Lion introduced 
back in 2012—macOS provides five ways to peek at a selected document in the Finder. You can:
• Press the Spacebar.
• Choose File > Quick Look.

• Choose Quick Look from the Action  menu in a window’s toolbar.
• Use the Quick Look   button if you’ve added it to the toolbar.
• For Force Touch trackpads: a light touch selects the file, a little pressure enlarges the icon a bit, and a full press opens the Quick Look 
window.

• Whichever method you use, you get a window with a full-size version of the selected file (screen real estate permitting). Click the Markup 
button in the window’s toolbar for the markup tools.
• Column-view windows: The final column of a window set to Columns shows the item chosen in the previous column. When it’s a 

markup-able item, a markup  button appears at the bottom of the pane.
• A window’s Preview pane: No matter what view you set for a Finder window—Icons, List, Columns, or (new in Mojave) Gallery—you can 
add a pane to the right side of the menu so you can see a large 
version of a selected item: choose View > Show Preview. This 
preview is more than just a big icon; you can, for instance, flip 
through a multi-page document. When the pane displays a 

markup-able document, there’s a markup  button beneath the 
image. 
• Any image file anywhere: Control-click any image file in the 
Finder and choose Quick Actions > Markup.
• On the floating thumbnail: In Mojave, when you save a 
screenshot as a file, it first appears as a thumbnail in the lower right of 
the screen. Double-click the thumbnail to open it in a markup 
window. But avoid this approach unless you’re doing a 
quick-and-dirty markup and sending it on its way (say, in Mail) for 
someone to see—because, as with other Finder-based markups, 
once you close the window, the markups “flatten”—they become 

Continued from page 1

Yes, that’s my family: my grandparents, father (the older boy), uncle, and 
aunt; the little girl is my Aunt Doris, who just celebrated her 90th birthday.
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part of the file and can’t be edited. But this mark-up-and-send approach is obviously what Apple expects you to do here, because 

a Share   button appears on the markup toolbar, and I’ve not seen that anywhere else.
Regardless of how you invoke the markup tools, you’ll get a toolbar across the top of the Markup window that displays six basic markup tools (one 

inoperable—the highlighter tool to the 
right of the text tool), a menu that offers 
a further ten, four formatting menus, 
two Rotate tools, and a Crop tool. (High 
Sierra lacks the Rotate and Crop tools, 
although it has cropping capability.)

To leave markup mode if you’re 
working in Photos, click either the Save 
Changes button or the Cancel button. You’ll be returned to the standard Photos Edit window, which you can exit by clicking Done or pressing 
Return. In other apps, the saving part is automatic; use the Done or Cancel button to close the Markup window.

The Sketch Tool
This tool is more magical than its pencil icon might indicate. Draw a line or a shape with the Sketch tool, and Markup attempts to smooth it out, 

even joining close-together ends. So, for instance, you can draw an almost-circle and get an actual one.
A little drop-down menu that appears from the tool icon offers two or three final-sketch options. One is to leave the item as you drew it, although 

it’s not always selected by default. If the freeform item resembles a shape, or a combination of shapes (like the “lollipop” in the figure below), that will 
be another choice; I’ve also occasionally seen two shape choices in the menu. A final option offers a super-smoothed-out version of your sketch. Leave 
your artwork as-is by dismissing the menu with a click of its close button; otherwise, click a suggested option.

In each case, you get blue resize 
handles on your sketch so you can alter 
its size; depending on the shape, you may 
also get green feature handles to change 
some contours, as in the second and 
third shapes here.

In the initial version of Mojave, 
pressing Return when the dropdown is 
active occasionally confirmed the 
highlighted choice, usually deleted the 
selected squiggle, and once made the 
TextEdit document I was drawing in just 
blink into non-existence. So, click your 
menu choice, and avoid the keyboard for this until you’ve tested it thoroughly in your environment.

The Draw Tool
The Draw tool is available only if you have a Force Touch trackpad; if you do, you’ll want to doodle with it because as you change the pressure on 

the trackpad, the line thickness changes. With some patience and practice, you can draw rather elegant swashes or the previously mentioned 
mustaches. When the Draw tool is selected, the line thickness choices in the Shape Style menu change from the standard offerings to special ones that 
define the thickness “range” you’ll be working with.

I found that in High Sierra, once I finished a squiggle, it 
often shrank noticeably as soon as it was done, but that glitch 
has disappeared in Mojave.

The Shapes Menu: Lines and Arrows
The Shapes menu provides six shapes: line, arrow, rectangle, 

rounded rectangle, ellipse, speech balloon, star, and hexagon. It 
also has two special tools, described separately ahead.

Line and arrow shapes are somewhat fluid, as you can draw 
a line and then apply a “shape style” that has an arrowhead, or 
draw an arrow and later apply a non-arrowhead style to it. 
Format the line/arrow shape with line thickness, line style, arrowhead placement, and even drop shadow choices from the Shape Style menu (detailed 
ahead). You can attach text to lines and arrows, as described later in “Tackle Text.”

A selected line or arrow shape has blue resize handles on each end with which you can change the length of the shaft (the size of the arrowhead is 

Top: Mojave’s markup tools. Bottom: High Sierra’s markup tools
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determined by the line thickness), as well as alter its orientation. 
The green mid-line feature handle changes the curve of the line; 
you can also slide the handle along the length of the line to 
reposition the farthest point of the arc.

When you drag either end of a line/arrow to change its 
orientation, pressing Shift after you start dragging snaps the object 
to a horizontal, vertical, or 45-degree position.

The Shapes Menu: Standard Shapes
The rectangle, rounded rectangle, ellipse, and speech balloon tools have much in common, and working with them is intuitive. A selected shape 

has blue resize handles on each of its sides and at its four corners; for ellipses and speech balloons, the handles live at the corners of their bounding 
rectangles. (Note that any of these shapes can also be a text container, as described later in “Tackle Text.”)

The speech balloon’s tail has green feature handles at its point and 
base that let you adjust its length, as well as the width and position of its 
base along the balloon edge. As with line objects, if you press Shift after 
you start dragging the tail to change its position, it will snap to a 
horizontal, vertical, or 45-degree angle.

Do you need thought balloons instead? There’s no special tool for 
that, but there is a special, hidden technique described in “Quick Tips” 
at the end of this article.

The Shapes Menu: Stars and Polygons
In addition to basic resize handles, star and polygon shapes have 

green feature handles that let you change the number of points/sides in 

the object. Select the object to get the handles (for a star, use the outer of 
the two). Drag the dot around the perimeter of the circle that appears; 
clockwise deletes points/sides, and counterclockwise adds them. A star can 
have up to twenty points, while a polygon can go to the twelve-sided 
dodecagon. Stars have a second feature handle that defines the inner 
perimeter of the star (and therefore the length of the points). As with other 
shapes, these can accommodate text, as described later in “Tackle Text.”
  The Shapes Menu: Highlight Tool
 This tool at the bottom of the Shapes menu works not by actually 
highlighting part of an image (which would alter the part of a photo you 
most want to emphasize) but by dimming everything else. It’s a cinch to 

use: draw a rectangle around the area you want 
to emphasize and press Return.

Resize the highlight rectangle by first clicking 
anywhere on the dimmed area, which puts resize 
handles around the highlight. But to move it, grab 
and drag outside the rectangle. It’s not intuitive, 
but think of the “highlight” as a semiopaque sheet 
with a cutout—which is pretty much what its tiny 
icon in the Shapes menu represents. Delete the 
highlight by clicking it and pressing Delete.

This everything-else-is-covered approach means 
you can’t move any already-created object, or draw 
new ones, in the dimmed area of the image. So, do 
all your other markups first, or get rid of the 
highlight, make your edits, and then redo it.

The Shapes Menu: Loupe Tool
Also at the bottom of the Shapes menu, this 
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wonderful little magnifier (named for a jeweler’s loupe) lets you enlarge 
one or more specific parts of an image. Click the tool for a magnifying 
circle to appear on the image. Reposition it by dragging, and use the 
blue resize handle to change the size and the green feature handle to 
change the magnification power.

You can also:
• Assign a color to the loupe’s rim by selecting from the Border 

Color menu and change its thickness and style using the Shape 
Style menu.

• Put more than one loupe on an image.
• Overlap loupe circles to increase the total magnifying power.
The Sign Tool
This signature-affixing tool is available in Markup for embedded 

images, except in the Photos app. The method is the same as for 
Markup signatures elsewhere in macOS; for detailed setup and usage instructions, check this Apple support page, which describes using the Sign 
feature in Preview.

The Crop Tool
Mojave’s Markup added a specific tool for cropping; previously, it was a 

baked-in capability that didn’t need a tool. And, unlike in High Sierra, 
Mojave’s markup cropping is available in Photos.

When you click the tool, a Crop button shows up at the right side of the 
Markup toolbar, and white cropping corners appear on the image. There are 
also hair-thin lines all around the perimeter; they’re hard to see, but not so 
difficult to grab—just trust that they’re there. As you adjust the crop lines, 
gridlines appear so you can center something in the cropped image or perhaps 
use the Rule of Thirds. Click the Crop button when you’re done; if you have 
immediate second thoughts, just click the Crop tool again and adjust the lines.

High Sierra has no explicit markup tool for cropping because it’s a baked-in, 
point-and-drag capability, except in Photos, which has native cropping 
capability. Just drag the blue corner or midpoint lines at the picture’s edges. 
Crop an image that you’re marking up in one of Apple’s apps by hovering at 
any corner or side midpoint to see the blue cropping guides, and drag them to define the crop area. The part of the image outside the crop marks 
won’t disappear until you click Done or Save Changes.

The Shape Style Menu
I started out thinking of the Shape Style menu as something that simply 

controls line thickness, but, as its name implies, it’s not that limited. In fact, 
it’s a bit of a Swiss Army knife, and, except for the arrowhead options, its 
settings also define shape borders. You can make your formatting choices 
before you use a tool, or afterward on selected objects.

Use the choices in its four sections to:
• Control line/border thickness. As described earlier, if you have a Force 

Touch trackpad and the Draw tool selected, the line-thickness choices 
show the two extremes of the widths with which you’d be working.

• Choose a special style for the line/border: dashed or “dry brush.” To 
use neither, you have to click on the already selected one to deselect it.

• Set a line to be plain or have an arrowhead on either or both ends.
• Add a discrete drop shadow to a selected object. If the object has no fill, 

there’s a shadow inside for its upper region.
Border and Fill Colors
These menus, whose icons indicate the currently selected colors, display identical palettes of colors in various shades. There’s a strip of basic 

(intense) colors along the top, and a Show Colors button at the bottom that opens the system Colors window for when the standard colors just 
won’t do.
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Tackle Text
Adding and formatting text for an image 

title, a label, or a speech balloon (finally, a 
valid use for Comic Sans!) is simple. You 
can start with the dedicated text box, or use 
almost any object as a text container.

The basics for text boxes are a cinch: click 
the Text button to create a text box, and 
start typing. I didn’t notice this in High 
Sierra, but in Mojave, you must click the 
“drawn” part of the icon to activate—not 
the empty space between the box and the 
letter (in High Sierra, the Crop tool had the 
same problem).

The initial placeholder Text is overwritten 
when you type, without your having to explicitly 
select it; the text box expands as you type. You can 
resize only the width of a text box; when you drag a 
blue resize side handle, its height changes to 
accommodate the text exactly: no more, no less.

To reposition an inactive text box, move the 
pointer over it; the pointer changes to a hand 
indicating you can grab and move it. If the text box is 
active, the pointer is a text cursor when it’s over text, 
so hover over an empty area of the box, or its 
perimeter, to get the Grab hand.

You can instantly add text to any object: just select it and start typing. So, for instance, you don’t have to place a text box within a speech balloon 
to add the speech. Unlike text boxes, however, shapes don’t automatically expand as you type; you must resize them manually to accommodate the 
text. If there’s text overflow when you type or resize an enclosed shape, you’ll see a little plus-sign overflow indicator at the bottom of the shape when 
it’s selected (text boxes aren’t as courteous).

You can even add text to some non-enclosed 
objects, such as sketched scribbles, or plain or 
arrowheaded lines. Start typing when the object is 
selected, and the text appears to the left of a 
predominantly horizontal object or above a mostly 
vertical one; the arrowhead stays glued to that end of 
the object as you reorient it. For arrows, it’s a handy 
way to label something that you’re (literally) pointing 
out. Unlike with other shapes, text attached to non-enclosed objects is limited to a single line, albeit a long one; the text area stretches horizontally as 
long as you type, even if it disappears off the edge of the image area.

To edit text in a text box or shape, click the object 
to select it, and then click again to place the insertion 
point. Double-click (faster than two single clicks) an 
inactive text container to select not only the shape, 
but also whatever word you clicked.

Apply formatting before or after you type with the 
myriad options from the Text Style popover; it 
includes choices for fonts, style, size, color, and 
paragraph justification. You can apply text 
formatting whether the text container itself is 
selected, or while you’re entering or editing text. 
Formats are applied to the entire block of text, even 
when only some of the text is selected.
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When working with text, keep in mind:
That handy initial typing-replaces-default-text-in-a-textbox approach unfortunately applies to a selected text container at any time—hit one or 

more alphanumeric keys when you’ve selected a container, and its text is immediately replaced. Undo does not revert it while the text is still active.
You can’t use Undo to change something you’ve mistyped or edited while you’re working in a text container. You must click outside the 

container and then use Undo—which undoes everything you just did within the container. In all, you’re better off just editing your typos or changes 
directly.

Manipulate Objects
Every markup item you place on your image is an object. Here’s what you should know about manipulating them:
• Select multiple objects: Click the first item and shift-click the others.
• Duplicate an object: Duplicate an object by Option-dragging it (press Option before you click). This can be a real timesaver when you use, 
say, multiple arrows or speech balloons: duplicate a formatted version and you won’t have to format each separately.
• Constrain an object’s movement: Restrict a drag to vertical or horizontal movement with the Shift key (press Shift after you’ve clicked the 
item).
• Resize an object:

• Drag a blue resize handle.
• Press Option while resizing an object by any selection handle, and it resizes, outward or inward, from the center.
• Shift-click a resize handle on a selected object to equalize its height and width.
• Shift-click the midpoint resize handle on the top or bottom of the shape to make all sides equal to the current height. Shift-click a midpoint 

side handle to make all sides equal to the current width.
• And Shift-clicking a corner handle? It makes equilateral sides that are the average of the length and width measurements. That’s what seemed 

to be happening when I eyeballed it—and then, because I just couldn’t help myself, I took by-the-pixel measurements of the original shape 
and the midpoint Shift-click results, and, yup, that’s what’s happening.

• Shift-click near a resize handle to resize an object by just a little bit: click outside the object to make it a little larger, or inside to make it a bit 
smaller. As with dragging a resize handle, the object changes size in the direction of the clicked spot, while the opposite side or corner of the 
object remains anchored.

• Option-click a resize handle and nothing happens. Option-clicking near a handle, however, is analogous to Shift-clicking near one, with a 
just-outside click enlarging the object and just-inside clicking making it 
smaller. But, because you’re pressing Option, it’s resized from the center. So, 
Option-clicking near any corner gives identical results, and there’s no 
difference between Option-clicking near the top or bottom handle, or the 
left or right side handles.

• Align objects: Align a dragged object with others on the screen by using the 
yellow guide that appears when objects’ vertical or horizontal centers, are aligned. 
(If you have a Force Touch trackpad, you also get a little tick of feedback against your finger when objects are aligned.) 

• Reorder object layers: Every object lives in its own layer, with each new one on top of all the others. To change the layer order when items 
overlap, Control-click an object and choose from the pop-up menu: Bring to Front and Send to Back move something to the top or bottom of 
the pile, while Bring Forward and Send Backward move an object one layer.
Undoing Markups
While you’re working in markup, Undo works as you’d expect, undoing your most recent change, then the one before that, and so on, with Redo 

heading in the other direction.
The Undo and Redo commands for Markup are synergistically related to the app you’re using. While working in Markup, I was hitting 

Command-Z without thinking about it, but when I paid attention, I realized that it’s the parent app’s Edit menu that’s being activated. But it’s not 
exactly the app’s Undo command, since, if you look at the Edit menu instead of just hitting Command-Z, you’ll see detailed commands such as 
Undo Text Change, Undo Remove Rectangle, Undo Change of Annotation Properties, Undo Change of Bounds, and my favorite, Undo Doodle.

But what about after you close the markup window? With embedded images, such as in TextEdit and Stickies, using Undo right after you leave 
markup mode undoes all the markups you just applied.  If you’re working in the Finder, in a Quick Look window or any of the ways I described 
earlier, once you close the markup window, that’s it—no more undo capability.

The Re-Markable Thing
In Mojave, after you’ve saved a marked-up image, you can usually change your mind, and go back and alter or remove your markups. Because 

High Sierra was not so kind across the board—and somewhat inconsistent—I tested this in Mojave for Photos, applications that handle embedded 
images (such as TextEdit and  Stickies), and even Mail. Almost no matter where you’ve done the markup, or what you’ve done to the base image in 
the “host” application—come out of Markup mode, saved and closed the document, quit and reopened the app—I found that markups remained 
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editable. Photos is especially accommodating, providing a special command (File > Export > Export Unmodified Original for Photo) so you don’t 
have to remove the markups manually for an unadulterated photo.

The big, and very disappointing, exception to this editable approach is the Finder. Work with Markup there, in any of the ways I mentioned 
earlier, including the screenshot-produced floating thumbnail, and your markups are permanent. (It’s worth noting here that Preview, where 
markup capabilities were first introduced and which still uses its own set of markup tools, always “flattens” its markups to become a non-editable part 
of the image.)

So, if you’re working in High Sierra, or in the Finder in Mojave, it would behoove you to work on a duplicate of your image or document if an 
unadulterated base image is important to you.

Quick Tips
It might seem like I’ve covered every possible option related to the Markup tools, but no! There’s more—these tips just don’t fit into any previous 

category.
Undo Rotation
You don’t have to worry about whether your markups are editable when it comes to the rotation of an image: just go back into markup and rotate 

it back to the original orientation. Even more convenient is that Rotate is a Quick Action available in the Finder—if you turn it on in System 
Preferences, as I described back in “Enable the Mac’s Markup Tools.”

Trackpad Tricks
There are some things you can do in markup only if you have a trackpad. Unlike the Draw tool, which requires a Force Touch trackpad to 

perform its changing-width trick, these work with any trackpad:
• Zoom In and Out: Zoom your image with a pinch or a spread (outward pinch) of your fingers.
• Rotate Items: A two-finger twist when an object is selected rotates it. (It’s much easier to keep one finger stationary and move the other; even 

easier is using one finger from each hand, with your dominant hand doing the moving.) Text and its container rotate together unless you put a 
text box inside a shape, which lets you rotate just one or the other for a special effect.

Editable Markups for PNG Files
When you add markups to a PNG file (screenshots are saved as PNGs) in the Finder, the changes are permanent—but where else can you open 

it? For editable markups starting with a PNG: Control-click the file, choose Open With > Other from the pop-up, and select the Photos app from 
the dialog. Photos opens, and the file is added to its collection; access the markup tools as described earlier in this article.

Thought Balloons
I initially wrote a tip about using an oval with circles of varying 

sizes leading to it, acknowledging that a smooth oval was not 
quite de rigueur for cartoon thoughts. And then I stumbled upon 
a delightful little feature. Simply use the Sketch tool to scribble a 
cloud-ish shape; you don’t even have to close it entirely, as long as 
you come close. When you’re finished, it turns into a proper 
thought balloon, leading bubbles and all. And, as with speech 
balloons, you can reposition the tail around the perimeter of the 
body, and dragged to be longer (although that simply spreads out 
the bubbles—it doesn’t add more).

If you sketch something less definite, with edges frilled enough 

to mildly suggest a cloud but whose overall perimeter does not, the drop-down 
suggestion menu includes a thought balloon option, just in case that’s what you 
meant.
And just so you can see thought balloons in a real-world use.
Markup in Received Email
  If you want to mark up an image someone emailed to you, you can’t do it in the 
message you’ve received. Instead, click the Reply button and work on the image in 
the Reply window.
  Note that the image appears in the Reply window only if you have Mail preferences 
set to include the received message in the reply. Set those preferences in Mail > 
Preferences > Composing, in the Responding section. If you don’t have Mail’s 
preferences set to show your received message in the Reply window, you can copy 
and paste the image from the message to the reply, or just drag the image from one 
window to the other.
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  Once you’re in a Reply window with the marked-up image, you can access markup mode through the little down-arrow button in its 

upper-right corner, as described earlier. In Mojave, you’re not limited to adding your own markups to those made by the sender; you can edit, or 
even entirely remove, the original markups.

Work on a Blank Canvas
Make a blank canvas if you want to just draw stuff and not edit an existing image. In TextEdit, start a new document and take a screenshot of the 

main part of the page, avoiding the ruler. Use the default Command-Shift-Control-4 to copy the white block to the Clipboard, and then paste the 
whiteness onto the page, where it will be treated as an image. Hover over the pasted area, and you’ll see the little down-arrow button that you can 
click to get the menu that lets you 
access Markup.

Touch Bar Features
A Touch Bar provides 

context-sensitive Markup controls. 
You’ll find handy (fingery?) 
choices such as: a button for creating a text box; a slider for line thickness; buttons 
for line styles (solid, dashed, dotted, dry brush); font size and styles (bold, italic, 
underline); paragraph justification; word completion suggestions (when you’re 
typing); arrowhead placement on lines; a color strip wherever it’s appropriate; and 
Cancel and Done buttons for when you have second thoughts or are finished.

A Special Bug in TextEdit
An annoying markup bug that plagued me in High Sierra has survived in 

Mojave, although it occurs less frequently. When reopening the Markup tools for 
an embedded image in TextEdit, often only a very truncated, somewhat 
translucent window opens showing the Markup tools but not the image. The 
deformed window closes when you click Cancel, but you must save, close, and 
reopen the document to access the markup layer.

Apple Establishes Repair Programs for iPhone X and non-Touch Bar 13-inch MacBook Pro
by ADAM ENGST

Every so often, Apple creates a repair program to address a problem that affects a significant number of Apple devices. These repair programs 
provide free service or component replacement regardless of whether or not the device is still under warranty or covered by AppleCare. The 
company has just established two new programs: one for the iPhone X and another for the non-Touch Bar model of the 13-inch MacBook Pro. 
Both of these programs will continue for 3 years from the first retail sale of the unit.

For each of these programs, you can find an Apple Authorized Service Provider, make an appointment at an Apple Retail Store, or contact Apple 
Support to arrange mail-in service via the Apple Repair Center.

Before you give any device to Apple for repair, make sure to back up your data first, since the repair may involve replacing storage. For a Mac, we 
recommend making both a bootable duplicate and a Time Machine backup; for an iOS device, it’s always worth making a backup via both iCloud 
and iTunes.

iPhone X Display Module Replacement Program for Touch Issues
On the iPhone X Display Module Replacement Program for Touch Issues page, Apple says that a failing component in some iPhone X 

displays may cause touch-related problems. The display, or part of it, may respond intermittently or not at all to touches, or it may react despite not 
being touched. If your iPhone X is suffering from these problems, Apple will replace the display module free of charge.

No other iPhone models are included in this program, although this sounds a bit like the repair program that fixed iPhone 6 Plus units suffering 
from so-called “Touch Disease” (see “Apple Launches iPhone 6 Plus Multi-Touch Repair Program,” 18 November 2016) and we have an 
iPhone 6 that has similar problems.

13-inch MacBook Pro (non Touch Bar) Solid-State Drive Service Program
While the problems with the iPhone X are undeniably troubling, the 13-inch MacBook Pro (non Touch Bar) Solid-State Drive Service 

Program is more urgent. Apple has discovered that some of the 128 GB and 256 GB SSD drives used in the non-Touch Bar model of the 13-inch 
MacBook Pro suffer from a problem that could cause data loss and failure of the drive. Affected units were sold between June 2017 and June 2018.

If you registered an affected MacBook Pro with Apple, the company says it will send you email about the problem as well. Regardless, you want to 
send your MacBook Pro in for service—free of charge—as soon as possible, before data loss occurs. You must make a backup first since the drive will 
be erased as part of the service. Apple will reinstall macOS for you, and you can restore from your bootable duplicate or Time Machine backup 
during the setup phase.
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iOS, watchOS, & tvOS 
Inside iOS 12: Use Third-Party Password Managers to Simplify Logins

by JOE KISSELL
iOS 12 makes several changes to the way passwords are handled; see Glenn Fleishman’s “SMS Text Message Login Codes Autofill in iOS 12 

and Mojave, but Remain Insecure,” 4 October 2018. My favorite addition to iOS 12 is support for using 
third-party password managers in login situations that were previously accessible only to iCloud Keychain. 
In case you haven’t tried this capability yet, I’d like to show you what it’s all about and why it’s so delightful.

The Old Way
Back in the dark ages (before September), the only way to use a third-party password manager to log in 

to a Web site in Safari or other browsers was by way of a Share sheet extension. Once you had enabled the 
extension, the process was to visit a page in your browser containing a login form, tap the Share icon, tap 
the icon for your password manager, unlock the password manager, tap the login item you wanted to use, 
and then (once you were returned to your browser), submit the form. That was a lot of cumbersome 
steps—enough that many people just used iCloud Keychain from within Safari instead because it required none of these extra steps.

To refresh your memory, iCloud Keychain vastly simplified this entire process by, when you tapped the username field of a login form, providing 
single-tap access to the username and then the password in the QuickType bar above the keyboard.

Now, iCloud Keychain isn’t terrible, but it’s neither as secure nor as flexible as I prefer. And, of course, it doesn’t sync with non-Apple platforms. 
So if you, like me, prefer to use a third-party password manager like 1Password or LastPass, you’ll be happy to know that iOS 12 requires far fewer 
steps to access your data there—and it makes that data available in virtually all apps, not just Web browsers.

Coming into the Light
Before you can make use of iOS 12’s new password manager integration, you have to tell iOS which one(s) you want to use. Go to Settings > 

Passwords & Accounts > AutoFill Passwords. Make sure the AutoFill Passwords switch at the top 
is turned on. Then tap an item in the Allow Filling From list to enable or disable it.

iCloud Keychain is always the first item, followed by any other installed password managers that 
support this feature. So far, compatible apps I’ve found include 1Password, Bitwarden, 
Dashlane, Enpass, Keeper, LastPass, RoboForm, and Zoho Vault. There may be others, and 
more will surely follow.

You may be wondering whether you should leave iCloud Keychain selected in addition to your 
third-party password manager. (You can select only one third-party password manager, in addition 
to iCloud Keychain, at a time.) It’s up to you, but I found that having both iCloud Keychain and 
another password manager selected sometimes led to confusion, so I suggest that you make sure all 
your important passwords are in your favorite password manager, and then have only that one—
not iCloud Keychain—selected as an AutoFill source.

I should point out here that deselecting iCloud Keychain in this list does not disable iCloud 
Keychain! It’s still active, and it still works behind the scenes to supply 
credentials for Wi-Fi networks, Mail, Messages, and so on. The AutoFill 
setting determines only whether browsers and other apps that display 
login forms may look into iCloud Keychain for their data.

The new AutoFill Procedure
That one-time setup behind you, the steps to fill in credentials on a 
Web site are blissfully simple:
1. Tap in the username or password field.
2. iOS 12 looks in whichever password manager(s) you have selected, 

and if it finds a likely match, it displays it in the middle of your 
QuickType bar—or, if the QuickType bar isn’t showing, in a 
popover at the bottom of the screen. (On rare occasions, it may 
display more than one option.) If you see the one you want, tap it, 
unlock your password manager if necessary (using your password, 
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Touch ID, or Face ID), and iOS fills in your credentials.

3. Tap the Submit button.
But what if, in step 2, iOS 12 does not suggest the credentials you want? No 

problem; tap the key icon on the QuickType bar or at the bottom of the screen. (The 
key icon appears by itself if there’s a suggested password; if not, it includes the label 
Passwords.) A popover appears listing other potential matches, if any; you can tap any 
of these to fill them in.

If that list still doesn’t contain what you’re looking for, tap the name of your 
password manager, unlock it, and locate the desired credentials there. Tap them to 
return to your browser and fill in the form.

Beyond the Browser
Web browsers may be the most common places to enter usernames and passwords, 

but lots of other apps require logins too. Think, for example, of the Dropbox app, Instapaper, Tweetbot, or an app supplied by your bank. These 
and countless other cases used to require switching back and forth between the app and your password manager to copy and paste your credentials. 
But in iOS 12, both iCloud Keychain and third-party password managers are available in nearly any app that uses passwords.

Unfortunately, no matter where you store your passwords, iOS 12 has no way to know which accounts go with which app. So, after tapping the 
key icon on an app’s login screen and tapping your password manager of choice, you’ll have to manually search for the desired account—it’s not 
quite as smooth a procedure as logging in to a Web site. I also found on 
numerous occasions that once back in the app, I had to tap in the username or 
password field before iOS 12 would fill in the credentials.

Furthermore, if you’re setting up a new account from within an app, iOS 12 
provides no mechanism whereby a third-party password manager can generate a 
suggested password and fill it in for you—unless the app displays a 1Password 
icon in its username or password field, meaning that it supports the old-style 
1Password App Extension (which other password managers can also use).

But Now, the Bad News
As great as this new password manager support is, it would be overstating the case to say that Apple has allowed third-party password managers to 

work entirely on par with iCloud Keychain. Some processes still require numerous cumbersome steps—and don’t get rid of that Share sheet 
extension just yet!

First, this new mechanism is for usernames and passwords only. It can’t be used to autofill other data that your password manager might store 
(such as credit card numbers, addresses, and phone numbers) and that would be available via a browser extension on a Mac or PC. You can still fill in 
that sort of data using the Share sheet extension.

Second, this autofill capability is one-way: it sends data from your password manager to your browser (or other app), but it can’t gather data from 
the browser and send it back to a third-party password manager. (In contrast, iCloud Keychain can autosave credentials as you submit them.) That 
means if you’re filling in a Web form with credentials that aren’t already stored in your password manager, the act of submitting the form won’t 
trigger the password manager to store them, as typically happens in desktop operating systems. Here are the steps you’d follow to save a new 
password this in 1Password (other password managers may differ slightly):

1. Tap the password field.
2. Tap the key icon.
3. Tap 1Password.
4. Unlock 1Password (using a password, Touch ID, or Face ID).
5. Tap Create Login.
6. Enter your username.
7. Tap Generate New Password.
8. Tap Save & Fill.
The same is true if you’re changing a password on a Web site. If you need a new password, you’ll want your password manager to generate it; then 

you’ll want to enter it on the site and store it in your password manager. With a desktop browser extension, this whole process is quick and easy (and 
Dashlane and LastPass make it extra easy for a limited number of sites, basically automating the whole procedure with just a couple of clicks). But 
because in iOS 12 your browser won’t send data back to your password manager, you’re stuck performing a multi-step process similar to the one 
above (or using the Share sheet extension, just as you would have done prior to iOS 12).

Postscript: Updates in Progress
Because both Apple and third-party password manager developers have been hard at work adding features and polishing their user interfaces, my 
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two password-related books (Take Control of Your Passwords and Take Control of 1Password), as well as my Wirecutter article about 
password managers, are all in need of revision. I’m working on all of the above (while also juggling an absurd number of other projects) and hope 
to have updates available soon.

JNUC 2018: How Organizations Use Apple Devices as Tools of Change
by ADAM ENGST

I’m writing this while at the Jamf Nation User Conference, better 
known as JNUC. It’s my second year at this conference, and while 
Jamf’s Apple-focused device management software has evolved and 
the 2000-plus attendees are busy learning about the latest best 
practices, at a high level, the conference is basically the same as last 
year—for details, see “JNUC 2017: A Glimpse into the World of 
Apple Enterprise” (3 November 2017). And once again, in the 
interests of full disclosure, Jamf has sponsored TidBITS in the past, 
and the company invited me and other journalists to attend, paying 
for travel and accommodations.

More interesting than the nitty-gritty of how Jamf Pro works are 
the ways that schools, businesses, and other organizations are using it 
to help enable large and innovative Apple-focused projects. For many 
of us, it’s hard to see beyond individual consumer use of Apple 
devices. So let’s step back from daily media frenzy and look at how 
technical professionals around the world are using Apple devices as 
organizational tools of change for education, healthcare, hospitality, and retail.

K-12 Education: Sewanhaka Central High School District
When he was in 8th grade in 2012, my son Tristan announced that he needed a TI-83 graphing calculator for his algebra class. It wasn’t cheap at 

about $110, and I was shocked to realize that it had been designed in 1996 and last updated in 2001. It was ancient technology, to be sure, but it 
was all that was approved for use on New York State’s standardized tests. And it couldn’t be used to cheat, as would have been possible on an iPhone 
or iPad equipped with a graphing calculator app.

So I was intrigued at JNUC to talk with Brian Messinger and Robert Pontecorvo, District Coordinators at Sewanhaka Central High School 
District on Long Island. Their district has five schools in very different communities, and they were struggling with equity issues surrounding 
graphing calculators.

For students whose families couldn’t afford the $110 calculator for a standardized test, the school would provide a loaner calculator, but it wasn’t 
something these students had access to all year, putting them at a huge disadvantage on the test. And while $110 may not sound like that much, one 
of Sewanhaka Central’s schools loaned out three calculators for the test, whereas another had to loan out 300. The test questions might have been 
standardized, but taking the test was anything but a level playing field. Simultaneously, students in other, richer districts were using more modern 
calculators that were easier to use and had more capabilities. Even Sewanhaka Central’s wealthier students were at a disadvantage compared to 
neighboring schools.

So Messinger and Pontecorvo worked with the New York State Education Department to create a 1-to-1 program that would provide iPads to 
8200 students and 800 teachers. They’re all equipped with the free GeoGebra graphing calculator app, which, as Pontecorvo said, “can do 
everything that a normal calculator does, but better” thanks in part to iOS’s direct manipulation interface, compared to using complicated key 
combinations for actions like zooming.

This system works for two reasons. First, the GeoGebra graphing calculator app is approved for use on the New York State standardized tests. 
That’s essential because, Pontecorvo said, his teachers refused even to consider previous iPad math apps because students wouldn’t be allowed to use 
them on tests. Second, with a Jamf Pro profile and workflow, the Sewanhaka Central IT department could lock all the iPads to use only GeoGebra 
during tests. No switching out to Safari to do a Google search or to Messages to ask for help.

Of course, iPads are more expensive than graphing calculators, but not vastly so, and bringing them in for educational equity reasons was a cleverly 
placed foot in the door. And now, with iPads across the entire student population, the district is standardizing on Apple’s Schoolwork and 
Classroom apps for class administration and teachers are using GeoGebra and other apps to improve instruction with a focus on creativity rather 
than rote learning.

I raised the question of keyboards, which Sewanhaka Central does not provide with its iPads. Pontecorvo said, “We’ve learned, and this was a 
mindset shift for me as well, that keyboards are an adult issue, not a teenage issue.” Apparently, the students are happier with the split keyboard and 
thumb typing.

Higher Education: Ohio State University
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Although it might seem counterintuitive, one of the primary drivers for the 1-to-1 iPad program that started this year at Ohio State University 

was cost savings. Ohio State’s Digital Flagship program issued 11,500 iPads to incoming freshmen this year, and the university designated 42 fall 
semester classes as “iPad required” due to the apps that the courses use. Each iPad also has a custom app that provides a course planner, grades, 
schedules, and a listing of student organizations, along with campus maps and bus routes. Unlike Sewanhaka Central High School District, Ohio 
State equipped its students with iPad Pros outfitted with cases, keyboards, and Apple Pencils, so students are ending up with highly capable systems, 
which they’ll get to keep when they graduate.

So how is this saving money? Again, iPads aren’t exactly cheap, but their price tags seem entirely reasonable compared to those of college 
textbooks—Ohio State’s students spend $61 million per year on textbooks and supplies. The university’s Affordable Learning Exchange program 
funds and supports faculty members in replacing expensive textbooks with open educational resources that are available for free. According to Mike 
Hofherr, Ohio State’s CIO, the freshmen are reportedly saving $230 per year by not having to buy as many textbooks. So far, Ohio State has saved 
students about $3 million, and the university hopes to increase the savings to $10 million per year in 2020. That’s a lot of iPads.

Perhaps the most impressive aspect of the Digital Flagship initiative was its rollout. Just imagine how much work it takes to hand out 11,500 fully 
equipped iPads to incoming freshmen. The university’s IT department was prepping 250 iPads per day for 2 months straight, bagging all the parts 
and registering the iPad in the Jamf Pro management system. And at distribution, of the 11,500 iPads, just 50 had some sort of problem out of the 
box, only 8 students didn’t want one, and there were only 2 technical errors.

Healthcare: University of California San Diego Health Sciences
I mentioned this program briefly in last year’s coverage, and Marc Sylwestrzak, Director of IS Experience and Development for UCSD Health 

Sciences, was back to provide an update. To recap, UCSD’s Jacobs Medical Center hands out an iPad to every patient in the 245-room hospital and 
equips every room with an Apple TV. The iPad provides access to patient health information, room controls via Crestron home automation, and 
entertainment through the Apple TV.

This is a completely different scenario from the high school and college installations, since the patients have the iPads only while they’re checked in, 
and any given iPad has to be configurable for any individual room and patient. On check-in, a patient is issued an iPad, with Jamf Pro coordinating 
with the hospital’s health information system to set it up for that patient and the appropriate room. Patients can install a selection of apps without 
entering an Apple ID or password. On discharge, a Jamf system called Healthcare Listener automatically wipes the iPad to ensure patient privacy and 
makes sure it is ready for the next person. (And yes, each one is cleaned with hospital-grade cleaning wipes between patients to eliminate “computer” 
viruses.)

Since inception, this automatic wipe system has been used over 32,000 times, saving an estimated 1400 hours and $65,000 over manual wipes 
annually. More important, patients who use the room controls on the iPad are nearly three times more likely to interact with their health records, 
making for more informed patients.

This initial project had proved so popular with patients that UCSD Health Sciences has expanded it to another 490 rooms in two other hospitals 
over the past few months. The other major change was made possible by a pair of new apps: Jamf Setup and Jamf Reset. The automatic setup and 
wipe system doesn’t work for outpatients, who don’t check into a room. It also falls down in situations like a NICU (Neonatal Intensive Care Unit), 
where multiple babies are in beds in a single room (and where the baby patients aren’t yet using an iPad). For a NICU, Jamf Setup allows a nurse to 
take an iPad, associate it with a particular bed and patient with a couple of taps, and give it to a visiting family member. When that person leaves for 
the day, either they or a nurse can wipe the device manually (since the baby isn’t being discharged) with a few taps using Jamf Reset.

UCSD Health Sciences is also working to provide iPhones to staff using these apps so a nurse or a member of the janitorial staff can check out a 
device for a shift on a certain floor or department. That enables communication with the person who is in a particular role, regardless of who it is at 
any given time. (Previously, Android phones were used, but they had significant Wi-Fi problems.)

As much as this sort of program is great, we’d all prefer to avoid hospital visits entirely. Nonetheless, the inevitability of being in the hospital as a 
patient or family member triggered an interesting conversation with UCSD’s Sylwestrzak about other uses for those iPads.

We first talked about using those iPads to make audio or video recordings of conversations with a terminally ill relative or bringing the outside 
world in via FaceTime. A Jamf employee at the table chimed in to say that he had lost his father a few years before, and only once did he think to pull 
out his phone and record the conversation, which is now one of the most precious artifacts his family has. Plus, with some of the lessons from 
end-of-life planning from La Crosse, Wisconsin in mind, we discussed the possibility of the iPad offering planning resources, or even providing a 
chatbot to help someone start a difficult discussion. That’s all pie-in-the-sky possibility for now, but it will need the ubiquitous availability of such 
technology to patients to come closer to reality.

Hospitality: Red Lion
On a lighter note, we may all wish to avoid the hospital, but most of us end up in hotels at some point. Every hotel room has a TV and some sort 

of entertainment system, but they’re usually hard to use. Plus, many people would far rather watch shows from their own Netflix account than 
channel surf randomly.

In an attempt to modernize the hotel experience, the Red Lion chain of hotels is experimenting with installing Apple TVs (with custom remotes) 
in all the rooms in its Hotel RL brand. But the project goes further, tying into an iOS app that lets travelers check in remotely, open the door using 
the iPhone instead of a keycard, and communicate with the hotel staff before (for room requests) and after (in case of forgotten items) the stay.
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The Apple TV runs a custom app that provides access to DirecTV for channel surfing, lets the user make room requests, and replaces the standard 

hotel notebooks that document hotel features and provide tourist and eating recommendations. Red Lion uses Jamf Pro to customize the app for 
each hotel location and room and to configure the Apple TV to default to that app. It also automatically wipes the Apple TV when the guest checks 
out and sets it up for the next person.

The one thing the system doesn’t yet do is provide access to streaming video apps like Netflix and Amazon Prime. Some other hotels with newer 
smart TVs do offer this, and the problem is that logging in can be devilishly difficult. The problem is authentication—it’s hard enough to log in to 
any account on the Apple TV due to its horrific onscreen keyboard, and that assumes you even know your password. Red Lion is trying to figure out 
if there’s a way to ask for and then transfer those authentication credentials with Jamf Pro and the MDM setup.

Although Red Lion’s system seems undeniably better than the average hotel setup and has received positive customer feedback, Red Lion CIO 
John Edwards admitted that people were still having some trouble getting their heads around it. The Apple TV interface may be easy, and Red 
Lion’s custom app was well-designed, but it all still assumes a level of comfort with digital interfaces that may not exist as broadly as those of us in the 
tech world think. Still, I’d love to give the system a try.

Retail: Rituals
The final case study for interesting uses of Apple devices managed through Jamf Pro comes from Rituals, a rapidly growing European cosmetics 

chain. Although there are only a handful of stores in the United States, Rituals operates 670 stores worldwide and is opening two new stores per 
week. That’s an insane rate of growth, but more interesting is how the company manages each store’s technology needs.

Rituals stores rely almost entirely on iOS devices. There’s always an iPad for the back office, which employees can use to maintain inventory, watch 
training videos, read email, access shared files, and do other management tasks. For the front of the store, although Rituals stores have a fixed cash 
register in case of technical failures, most sales are completed by an employee carrying an iPod touch. They also use the iPod touch to do 
stock-keeping, complete with a bit of gamification to get employees to build small amounts of product counting in each day rather than spending an 
evening auditing the entire store’s inventory. Each store also gets an iPhone for contacting the warehouse and for any tasks that might take place 
outside of Wi-Fi range.

The use of the iPod touch is worth noting. Joost van der Zwaan, ICT Solutions Architect at Rituals, said the most important reason for choosing 
Apple’s little-discussed iPod touch was its size—most Rituals salespeople are women, and they can carry or pocket the iPod touch much more easily 
than an iPhone or iPad. It doesn’t hurt that it’s notably cheaper than an iPhone.

As at UCSD Health Sciences, these iOS devices aren’t personal devices—they have specific roles to play, with a custom selection of apps that each 
role requires. If a device breaks, or it’s necessary to press the back-office iPad into checkout service during an especially busy time, the Rituals IT staff 
can use Jamf Pro to wipe it and reconfigure for the new role.

Going Beyond the Individual
I found these stories intriguing because they challenge our standard view of Apple gear as focused on the individual end user. That’s largely what 

Apple wants us to think, of course, and it’s also reflected technically—iOS doesn’t support multiple users. (That said, I was told at JNUC that 
Microsoft’s Office apps for the iPad do offer multi-user support to enable the separation of personal and work documents with different access 
controls.)

And yet, outside of its mainstream marketing, Apple does acknowledge that organizations need to buy and distribute hundreds or even thousands 
of devices with preset configurations. However, Apple’s own device management tools—Profile Manager in macOS Server, for instance—don’t scale 
to the levels discussed here, much less the 134,000 Macs used by IBM employees.

That’s where Jamf Pro—or a competing device management system like Addigy, FileWave, and SolarWinds—is necessary. As these stories have 
shown, for multitudes of Macs and iOS devices to meet the role-based needs of organizations, IT administrators need finely grained and highly 
automatable control over the setup and usage of these devices.

As this trend toward large institutions deploying numerous Apple devices as an integral part of their organizational missions continues, we will all 
increasingly find ourselves interacting with and relying on these managed devices while getting an education, receiving healthcare, staying in a hotel, 
or simply making a purchase in a store. These devices may not be “personal” in the ways we’re accustomed to, but Apple’s attention to usability and 
design, coupled with device management systems, means that they can serve highly specific purposes in ways that nothing else could.

ExtraBITS
SubEthaEdit Is Back and Free to All -- The SubEthaEdit text editor, whose real-time collaborative editing features were jaw-dropping when it first 
came out, is back with version 5, and is now free and open source.

Jason Snell Compares Mimeo and Motif Photos Project Extensions -- Wondering about the best approach for making a book or calendar as a 
holiday present, now that Apple has gotten out of the business of print projects? Over at Six Colors, “Take Control of Photos” author Jason Snell 
compared Mimeo and Motif.
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How to Work Around Wi-Fi Hotspot Captive Portals on Browserless Devices
by JOSH CENTERS

Many public Wi-Fi hotspots—such as those offered in hotels and hospitals—require you to authenticate with a “captive portal” page before 
allowing your device to access the Internet. Usually, this is as simple as clicking an “I Agree” button on the page. There’s just one problem: devices 
like the Apple TV and Nintendo Switch don’t have Web browsers and thus can’t 
access these pages (the Switch apparently has one for this purpose, but it has never 
appeared when I need it). Fortunately, if you happen to have a MacBook nearby, 
it’s an easy problem to solve.

The trick is to disguise the MacBook as the browserless device you want to 
connect—say an Apple TV—click through the captive portal, and then disconnect 
the MacBook and connect the device. You can do this by spoofing the Apple TV’s 
MAC address, which is a unique hardware identifier for a network device. Every 
Ethernet port and Wi-Fi card has a MAC address. Follow these steps:
1. Find the MAC address of the browserless device you want to spoof. On the 

Apple TV, it’s listed in Settings > General > About. If you’re using Wi-Fi, it 
will be called the Wi-Fi Address and will look like this: 00:14:22:01:23:45.

2. Power down the browserless device, or at least make sure it’s not connected to 
Wi-Fi—the easiest way to do this with an Apple TV is to unplug it. These Wi-Fi hotspots allow only one unique MAC address at a time so if 
it’s connected it could prevent your MacBook from connecting in the following steps.

3. Look up your MacBook’s Wi-Fi interface name and MAC address by Option-clicking the Wi-Fi icon in the menu bar. The interface name 
should be en0 or en1. 

4. Choose Turn Wi-Fi Off from the Wi-Fi menu.
5. Open Terminal and enter this command, replacing en0 with your interface name and 

00-14-22-01-23-45 with your browserless device’s MAC address: sudo ifconfig en0 ether 
00-14-22-01-23-45
Yes, you need to replace the colons with hyphens. Enter your administrator password when 
prompted. This command changes the MAC address of your MacBook’s Wi-Fi card, but 
only until you reboot!

6. Option-click the Wi-Fi icon in the menu bar again and double-check to make sure your 
MAC address has changed.

7. Turn Wi-Fi back on, connect to the hotspot’s Wi-Fi network, and bring up the captive portal by trying to visit a Web site in Safari.
8. Follow the prompts to authenticate the MacBook.
9. Once you’ve gotten online, restart the MacBook to restore its true MAC address.

Now you should be able to connect your Apple TV or other browserless device directly to the Wi-Fi network in question simply by powering it 
on or connecting to Wi-Fi.

If you have to pay for the hotspot and don’t want to incur the cost for a second device, you can use both your browserless device and your 
MacBook, as long as you keep the same MAC address on both and don’t connect them at the same 
time. So in Step 9 above, instead of rebooting the MacBook, turn Wi-Fi off, connect your 
browserless device, and when you’re done, disconnect the browserless device and turn on your 
MacBook’s Wi-Fi.

This trick could save your sanity if you’re on a business trip or stuck in a hospital for an extended 
stay and want to kill time by watching TV or playing video games. I was in this situation recently 
during the birth of my second son—welcome Jeremiah Stone Centers!—initially for his birth and 
then again so he could be placed under a bili light for two days to treat his newborn jaundice (he’s 
fine now). In my experience, most time spent in a hospital as a family member is just sitting around, 
but I was too tired and stressed out to be productive. Being able to play games on my Nintendo 
Switch helped pass the time while Stone was busy cooking under his light.

The Internet

https://www.imore.com/how-use-hidden-web-browser-nintendo-switch
https://www.imore.com/how-use-hidden-web-browser-nintendo-switch
https://tidbits.com/uploads/2018/11/Captive-Portals-1.jpg
https://tidbits.com/uploads/2018/11/Captive-Portals-1.jpg
https://medlineplus.gov/ency/article/002394.htm
https://medlineplus.gov/ency/article/002394.htm


20

“Hacked Account” Blackmail Spam on the Rise—Beware!
by ADAM ENGST

You open your inbox and see a message labeled “Change your password immediately. Your account has been hacked.” Inside, the email contains 
what it claims is one of your passwords, a threat, and a demand for money. The password is indeed one you’ve used in the past—how did the hacker 
get it? Could you really have been infected with malware?

This “blackmail spam” has been inundating inboxes across the Internet, and while there’s no way to know how effective it is, it has caused plenty 
of raised pulses. Written in deliciously fractured English, the email message purports to be from a hacker who has taken over your computer and 
installed spyware that has 
revealed your brazen 
browsing habits. The hacker 
also claims to have taken 
pictures of you (staring 
intently, one presumes) 
while you click through “the 
big delight of your favorite 
resources” and threatens to 
share them with your 
contacts and brick your 
computer unless you send a 
payment using Bitcoin.

What has caused concern 
for lots of people is that the 
blackmail spam “proves” 
that it’s legitimate by 
showing you a password 
that you’ve used in the past. 
(This is often the case, but 
not universally so. Most 
copies of this spam that I’ve 
received include passwords I 
never used.) Hopefully, the 
revealed password is not one 
that you’re still using, since it 
was extracted from one of 
the many large password 
breaches that have occurred 
over the last decade. To see 
which breaches might 
include one of your 
passwords, check your 
address at Have I Been 
Pwned. (It’s worth noting 
that most of the passwords 
that attackers have decrypted 
are short and insecure. If 
your password was over 12 
characters and didn’t use 

Computer Security

Be sure to read the entire thing—it’s hilarious!
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dictionary words or well-known patterns, it may have resisted decryption.)

To make this painfully clear, everything in the message other than your email address and breached password is fabricated. Your computer has not 
been hacked, there is no malware spying on your browsing, no pictures of you have been uploaded to a remote server, and so on. You have nothing 
to worry about, and you should feel free to mark the message as spam and get on with your life.

If your friends and colleagues ask you about similar blackmail spam, point them to this article and reassure them that they have nothing to worry 
about. Unless, of course, they’re still using the password that was revealed, in which case they should change it immediately.

Nonetheless, this spam marks what I fear is a turning point in malicious Internet communications. Most spam and phishing messages are almost 
entirely generic, with their main customization being your email address and occasionally your name. Sometimes they spoof a friend’s address or are 
even sent from a friend’s compromised account, but that’s about it. Such spam messages are convincing—to the extent that they are—only because 
of some larger context or because they tap into common desires to get or save money, be more attractive, or partake of some of that brazen browsing. 
(I’m trying hard to avoid triggering overeager spam filters with more specific words here!)

But not this message. The believability of this blackmail hinges on the fact that—in theory—only you know your password. If the blackmailer can 
know your password, you think, perhaps their other claims are true too. They’re not, but even people whose browsing habits are always G-rated 
often report a moment of panic. I presume those who still use ancient insecure passwords experience more than a moment of panic, and well they 
should.

The problem is that old stolen passwords are just the tip of the iceberg when it comes to information about us that’s readily available online. This 
blackmail spam combines only two bits of information—your email address and password. What happens when similar attacks expand the amount 
of information they use?

Some breaches, like the Apollo breach that took place 
in July 2018, include lots of other types of personal 
data—places of employment, roles held, locations, and 
corporate revenue numbers. Even more data is available 
in public databases. The New York Times recently 
published an article about apps that use voter 
registration and voting records to encourage friends to 
vote, but it’s easy to imagine that data being used for 
malicious purposes. Then there are real estate records, 
bankruptcy filings, divorces, and so on.

Blackmail spam taken to its logical extreme is the 
ultimate example of why we all have something to hide. 
It’s not that anyone has necessarily done anything that 
embarrassing, but the chance that we could be 
blackmailed into paying to keep certain facts under wraps 
is increasing. Imagine blackmail spam that threatens to reveal your likely voting history to everyone in your neighborhood who is registered with the 
other party. Or blackmail spam that says it will tell everyone on the Internet with your last name about your bankruptcy or divorce. Blackmail spam 
doesn’t even have to be true to be damaging. What would be the hit to your career if a spammer targeted everyone at your company’s domain name 
with an anonymous message that accused you of having committed sexual assault a few years ago and said that the sender was too terrified to identify 
themselves?

I don’t like to feed privacy paranoia, but as criminal organizations acquire more data science skills and ever larger datasets, such attacks will become 
all the more sophisticated and believable. It may not happen overnight—people with such skills can usually find legitimate employment more 
easily—but just as organized crime groups now have or can hire skilled programmers to create malware, they’ll eventually be able to find people who 
can combine every available piece of data about you and weaponize it in numerous ways. Similarly, it has become clear that governments aren’t 
above sowing fear, dissension, and confusion in the general populace, and they probably have the resources to do this already.

The worst part is that I can’t imagine a good defense against such attacks. Spam filters work against traditional spam because you’re protected if 
you don’t see the message. But you not being aware of a threat won’t prevent a blackmailer from carrying it out. Blocking payment methods or 
tracking payments may be effective in the real world, but cryptocurrency systems make such payments harder to track, if not completely anonymous 
when the money comes out of an exchange. But even that wouldn’t protect against a dedicated state actor looking to introduce strife into society.

Enhanced privacy legislation that limits the amount of data available about us online could help prevent or reduce the severity of these attacks. 
Though it’s far from perfect, Europe’s GDPR is a step in that direction. Here in the United States, however, serious privacy legislation probably 
won’t stand a chance—at least until the politicians who oppose it have had their lives laid bare for all to see, just like the rest of us.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet topics. For 
free email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com.
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Amazon Kicks Out Unauthorized Apple Refurbishers -- Apple and Amazon have signed an agreement that will let Amazon sell Apple products 
again, but an unanticipated side effect is that Amazon is also banning companies that sell refurbished Apple products without Apple's authorization.

David Barnard Explains How to Game the App Store -- Developer David Barnard is tired of scammy copycat App Store apps, and he’s divulging 
all of these developers’ tricks in an effort to call Apple’s attention to them.

Apple Music Is Coming to Amazon Alexa -- In a shocking announcement, Amazon has announced that Apple Music will soon be available 
through its Alexa voice assistant on its Echo smart speakers.

No Snoozing Allowed: Better Ways to Deal with Email -- Email management is, for most of us, a constant battle to deal with an uncontrollable 
number of messages in a finite amount of time. Many email apps try to “help” with tricks to hide email messages until later, but these are 
counterproductive. “Take Control of Your Productivity” author Jeff Porten suggests better methods.

Diagnose Mac Boot Problems with Howard Oakley’s Diagram -- If you’re racking your brain trying to figure out all the reasons why a Mac isn’t 
booting, Howard Oakley has developed a diagram that reminds you of all the boot steps, problems that can occur at each one, and possible 
solutions.

SMS Database Leak Exposed 2FA Login Codes -- An unsecured server has resulted in tens of millions of SMS messages being exposed, and along 
with it password reset links, two-factor authentication codes, shipping notifications, and more.

New Macs Separate Speaker and Headphone Jack Audio -- Rogue Amoeba’s Paul Kafasis has uncovered a key improvement in the latest Macs: 
the speakers and headphone jack are separate, independent audio devices.

Apple Confirms That the T2 Chip Limits Mac Repairs -- If you try to repair a newer Mac equipped with a T2 chip yourself, or if you take it to 
an independent repair shop that isn’t authorized by Apple, you may be in for a nasty surprise.

Backblaze Releases Q3 2018 Hard Drive Reliability Numbers -- Online backup service Backblaze has released its latest hard drive reliability 
statistics, showing excellent reliability for new high-capacity drives. If you’re looking for a new drive, you’d do well to buy the drives that have worked 
well for Backblaze.

TipBITS: Using the iPhone Camera’s Zoom Button
by JOSH CENTERS

In all iPhones, when you’re taking a photo with the Camera app, you can 
zoom by putting two fingers on the viewfinder and moving them apart—the 
traditional pinch-to-zoom. However, the zoom level can be hard to control 
precisely, which becomes an issue on the “big” iPhones—the iPhone 7 Plus, 
iPhone 8 Plus, iPhone X, iPhone XS, and the iPhone XS Max. That’s because 
those models sport dual cameras that support 2x optical zoom—at any level 

other than 1.0 or 2.0 
you’re using digital 
zoom that trades zoom 
level for picture quality. 
(As Glenn Fleishman notes at Macworld, the iPhone might use digital zoom regardless of 
zoom level, depending on the conditions).
  To address that, Apple enhanced the Camera app on those models with an additional way 
of zooming, a visible zoom button in the viewfinder, above the shutter button.
  We’ve recently learned that not everyone realizes what this zoom button can do. It has three 
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functions:
• 1x/2x zoom toggle: Tap the button to switch between 1x and 2x. If you’re on an 

oddball zoom level, like 7.4x, a quick tap takes you back to 1x.
• Incremental zoom control: Place a finger on the button and drag to move the circular 

slider between 1x and 10x zoom, in increments of 0.1. The button doesn’t move when 
you switch orientations, so in landscape orientation, dragging it down increases the 
zoom and dragging it up reduces it. In portrait orientation, dragging it to the left 
increases zoom and dragging it to the right reduces it.
Zoom level indicator: When you use the traditional pinch-to-zoom approach, the zoom button shows the zoom level.
If you want to see the zoom button in action, here’s a quick video showing how to use it.

What Happened to 5K Displays?
by ADAM ENGST

With the recent releases of the MacBook Air and the Mac mini, Apple made a point of saying that they can drive a 5K display running at 
5120-by-2880 resolution with a refresh rate of up to 60 Hz. That sounds great, but if you’ve been assuming that you could waltz out and buy such a 
5K display, you might need to think again.

My Kingdom for a 5K Display
Although the 27-inch iMac with 5K Retina display and iMac Pro both have 5K displays built in, Apple doesn’t 

currently make a standalone 5K display, or, in fact, an external display of any sort. When Apple dropped its 27-inch 
Thunderbolt Display (see “Apple Discontinues Thunderbolt Display with No Replacement in Sight,” 27 June 
2016), the company worked with LG on a replacement: the $1299 LG UltraFine 5K Display.

So you could buy an LG UltraFine 5K Display, but you might not want to. That’s because the availability of that 
monitor seems to be in decline, with AppleInsider reporting that Apple Stores say it hasn’t been restocked in a while 
and that it’s not available for in-store pickup when ordered online. With luck, its availability is dropping because LG is 
replacing it with a new model, but LG could just be running down stock before discontinuing it.

The Wikipedia page for 5K resolution lists a small number of other 5K displays, including screens from Dell, Philips, and HP, but as far as I can 
tell, none are currently for sale, apart from a handful of ultra-wide monitors with unusual aspect ratios like 64:27 and 32:9. Also on that list is the 
Iiyama ProLite XB2779QQS, but its page on Amazon says it ships directly from Japan and has absolutely no ratings or reviews, which is 
suspicious.

In short, the LG UltraFine 5K Display appears to be the only 5K display you can buy today, and you would have to order it online, sight unseen. 
If you can wait, it’s possible that LG will have a new model, and Apple has said that it will be releasing an Apple-branded professional display 
alongside the revamped Mac Pro in 2019. Apple has said nothing about specs, but it’s hard to see the company selling a screen that doesn’t at least 
match up to its iMacs.

What’s going on here? There are innumerable 4K displays for sale, but only one 5K display? There are some possible explanations, such as the 
industry standardizing on 4K, there being interface issues for all but the most recent computers, the panels being hard to manufacture in quantity, 
the costs being too high for the perceived win over 4K, or even 8K being the next jump instead of 5K. I have no answers here, but if anyone knows 
more about this part of the industry, let me know.

How Did We Get Here? And Where Are We Going?
In October 2014, Apple introduced the 27-inch iMac with 5K Retina display with 5120-by-2880 resolution, and it was, if you’ll pardon the 

expression, a true eye-opener. It wasn’t the first Retina display from Apple—that honor goes to the iPhone 4 introduced in 2010—nor was it the 
first Retina display used on a Mac, which was 2012’s 15-inch MacBook Pro with Retina display. But the 27-inch Retina iMac’s screen was huge, 
making it a different beast than the smaller iPhone and MacBook Pro screens.

The point of “Retina,” which is now an Apple trademark, is to make the pixel density of a display high enough that text and images on the screen 
become sufficiently crisp that the human eye can’t detect individual pixels. The closer you get to a screen, the easier it is to make out individual pixels, 
so Retina doesn’t refer to an absolute resolution, but instead one that varies with the size of the device and the distance from which the user would 
generally be viewing. You hold an iPhone much closer to your face than you do an iMac. Or at least I do.

The iPhone 4 had a pixel density of 325 pixels per inch (ppi), the MacBook Pro screens are 220 ppi, and the iMac Retina screens are 218 or 219 
ppi. The Mac screens haven’t changed over time, but Apple increased the iPhone X’s pixel density to a whopping 458 ppi.

A “5K” display is generally defined as one having about 5000 pixels of horizontal resolution; similarly, a 4K display has about 4000 pixels 
horizontally. Although you can theoretically run a 5K display at its native resolution, the text would be too small for most people to read, unless you 
were to get really close. Instead, macOS scales the resolution by default, so the 27-inch Retina iMac’s default setting is for a scaled resolution of 2560 
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by 1440. With scaling, macOS combines four native pixels (a 2-by-2 matrix) into one scaled pixel, and since it can adjust the color of each pixel, the 
result is a crisper look.

When the 27-inch Retina iMac came out, I bought one nearly instantly. I was ready for a new Mac, the performance was stellar for the time, and 
the screen was absolutely gorgeous. The only problem was that my main Mac has always been a dual-display system, dating back to the SE/30 with 
a 13-inch Apple Color Display in 1990. In 2014, there was no equivalent 27-inch 5K display that I could pair with the iMac, so I settled for Apple’s 
now-obsolete 27-inch Thunderbolt Display. It has a native resolution of 2560 by 1440, identical to the iMac’s scaled resolution, which gives me a 
single rectangular Desktop. I’ve been using that combination since 2014, but it has never been ideal. I can feel the difference in quality every time I 
look to my left at the Thunderbolt Display, and I have to make sure to take all screenshots on the iMac’s screen for maximum resolution—
screenshot resolution, it turns out, varies by screen.

I initially assumed that 5K displays would become commonplace and that at some point they’d get cheap enough that I could justify replacing the 
27-inch Thunderbolt Display with a 5K display that would give me the same scaled resolution as the iMac. That hasn’t happened, though, so I’ve 
decided to wait and see what Apple comes out with for the Mac Pro. It will undoubtedly be a Thunderbolt 3 device, so I’ll have to contend with 
replacing my iMac at the same time.

I hope that Apple pays more attention to the industrial design of this new display in conjunction with the iMac and the iMac Pro. Part of the 
problem with the 27-inch Thunderbolt Display when paired with a 27-inch Retina iMac is that the iMac is about an inch (2.5 cm) taller than the 
Thunderbolt Display. Since Apple doesn’t let you adjust the height of either device, the only way to get the two screens at the same height is to put 
the Thunderbolt Display on a book or other riser. It’s a kludge, and I expect better of Apple’s vaunted designers.

It’s hard to see the broader display industry getting behind 5K displays in a big way at this point. Apple often releases new technologies before 
other companies, which sometimes makes Apple’s engineers seem prescient and at other times causes Apple’s products to end up in technological 
cul-de-sacs. The 5K display may be one of those dead ends, but it won’t matter to Mac users if Apple’s pro display is good enough and not insanely 
expensive.
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.
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Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($30) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $30.00  APR 1 to JUN 30 - $20.00
 JUL 1 to SEPT 30 - $15.00  OCT 1 to DEC 31 - $10.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc.    
2100 Wood Avenue
Colorado Springs, CO 80907-6718 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

http://www.smmug.org
http://www.smmug.org

